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SUMMARY:  29 
Here, we present methods for high-throughput study of a series of the Mexican cavefish 30 
behaviors and vital staining of a mechanosensory system. These methods use free-software and 31 
custom-made scripts, providing a practical and cost-effective method for the studies of 32 
behaviors. 33 
 34 
ABSTRACT:  35 
Cave-dwelling animals have evolved a series of morphological and behavioral traits to adapt to 36 
their perpetually dark and food-sparse environments. Among these traits, foraging behavior is 37 
one of the useful windows into functional advantages of behavioral trait evolution. Presented 38 
herein are updated methods for analyzing vibration attraction behavior (VAB: an adaptive 39 
foraging behavior) and imaging of associated mechanosensors of cave-adapted tetra, Astyanax 40 
mexicanus. In addition, methods are presented for high-throughput tracking of a series of 41 
additional cavefish behaviors including hyperactivity and sleep-loss. Cavefish also show 42 
asociality, repetitive behavior and higher anxiety. Therefore, cavefish serve as an animal model 43 
for evolved behaviors. These methods use free-software and custom-made scripts that can be 44 
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applied to other types of behavior. These methods provide practical and cost-effective 45 
alternatives to commercially available tracking software. 46 
 47 
INTRODUCTION:  48 
The Mexican tetra, Astyanax mexicanus (Teleostei: Characidae), is unique among fishes for 49 
having two radically distinct alternative morphs — a sighted, surface-dwelling morph and a blind, 50 
cave-dwelling morph comprised of several distinct populations1. Although different in 51 
morphology and physiology, they are still interfertile2,3. These interfertile morphs appear to have 52 
evolved rapidly (~20,000 years)4, which makes them an ideal model system for the study of rapid 53 
adaptation. Cavefish are known to have a suite of divergent morphological and behavioral traits 54 
including increased density of taste buds, increased number of mechanosensors, foraging 55 
behavior tuned to a particular frequency of a vibrating stimulus, hyperactivity, and sleeplessness. 56 
Many of these behaviors likely evolved simultaneously, some of which have been suggested to 57 
be advantageous in the darkness of caves for foraging5 and conserving energy in dark and food-58 
sparse environments6,7. 59 
 60 
In many evolutionary model systems, it is difficult to acquire integrated knowledge on how 61 
animal morphology and behavior change in response to the environment because most species 62 
are distributed across a continuous gradient in complex environments. However, the stark 63 
contrast between the cave and surface morph Astyanax that evolved in highly contrasting 64 
environments delineated by a sharp ecotone has led to Astyanax emerging as an excellent model 65 
to understand animal evolution. This makes it possible to more easily link genes and 66 
developmental processes with adaptive traits and selection in the environment. Furthermore, 67 
recent biomedical investigations of these traits in Astyanax has shown that these traits may 68 
parallel human symptoms8–10. For example, loss of sociality and sleep, and gain of hyperactivity, 69 
repetitive behavior, and cortisol level are similar to what is observed in humans with autism 70 
spectrum disorder8. 71 
 72 
To address the complex co-evolution of many behaviors and morphological traits, it is 73 
advantageous to assay many of them to highlight underlying genetic and molecular pathways. 74 
Present herein are methods for characterizing the degree of cave-type behavioral phenotypes of 75 
surface, cave, and hybrid morphs of Astyanax. The focal behaviors analyzed to characterize 76 
phenotype are cave-adapted foraging behavior (vibration attraction behavior, referred to 77 
henceforth as VAB), and hyperactivity/sleep duration11,12. Also presented is an imaging method 78 
for the sensory system associated with VAB13. Recently, many open-source tracking software for 79 
running behavioral assays have become available14,15. These work very well for short videos, less 80 
than 10 minutes long. However, it becomes problematic if the video is longer because of intense 81 
computation/tracking time. Capable commercially available software can be expensive. The 82 
methods presented mainly use freeware and therefore are considered cost-effective and high-83 
throughput methods. Also included are representative results based on these methods. 84 
 85 
PROTOCOL:  86 
 87 
All procedures are performed following the guidelines described in “Principles of Laboratory 88 



   

 
 

Animal Care” (National Institute of Health publication no. 85-23, revised 1985) and the approved 89 
by University of Hawai‘i at Manoa Institutional Animal Care and Use Committee animal protocol 90 
17-2560-3. 91 
 92 
1. Vibration attraction behavior (VAB) assay (≤10 min for entire recording procedure) 93 
 94 
NOTE: Use an infrared sensitive camera or build an infrared camera by modifying a USB 95 
webcam. To modify a USB webcam, see a detailed description presented by the Keene Lab in 96 
this cavefish issue at JoVE (From this A. mexicanus issue), or a brief description in the 97 
Supplementary Materials. 98 
 99 
1.1. Recording setup 100 
 101 
1.1.1. To ensure that the camera remains in position, still, and at the proper focal length from 102 
the subject(s) being recorded, build a black box frame out of polyvinyl chloride (PVC) pipes, 103 
measuring 120 cm H x 45 cm L x 90 cm W.  104 
 105 
1.1.2. After construction of the frame, cover it with a plastic blackout curtain such as the one 106 
intended for hydroponic agriculture.  107 
 108 
1.1.3. On top of the frame, put a black acrylic board with a window for the infrared camera at 109 
the center measuring the same diameter as the C-mounted adjustable zoom lens. Inside this 110 
box, place the VAB assay equipment (Figure 1). 111 
 112 
1.2. Vibration apparatus  113 
 114 
NOTE: Vibrations are produced using a small function generator.  115 
 116 
1.2.1. For the following methods, tune vibrations to an amplitude of 0.15 mm and a frequency 117 
of 40 Hz, which is the frequency that elicits a maximum response of attraction5,16.  118 
 119 
1.2.2. Connect the function generator to a horizontal facing speaker.  120 
 121 
1.2.3. Attach a 7.5 mm diameter glass rod 14 cm in length to the dust cover on the face of the 122 
speaker by using hot-glue or a gasket adhesive.  123 
 124 
1.2.4. Perpendicular to this rod and facing downward, attach another 7.5 mm diameter glass 125 
rod 4 cm in length (Figure 1).  126 
 127 
1.3. Behavioral assay 128 
 129 
1.3.1. Acclimate an experimental A. mexicanus for 4 days in a cylindrical assay chamber filled 130 
with conditioned water (pH between 6.8 – 7.0, conductivity approx. 700 µS, temperature 131 
approx. 22 ˚C) with a 12/12 L/D cycle. Check whether fish have acclimated by observing their 132 



   

 
 

latency to forage. Longer latency than in their home tank indicates more acclimation time is 133 
needed. Throughout acclimation, feed once a day with live Artemia nauplii. 134 
 135 
1.3.2. The day prior to the day of the assay (after 3 days of acclimation), replace water in the 136 
assay chamber with fresh conditioned water. 137 
 138 
1.3.3. On the day of the assay (after 4 days of acclimation), deprive experimental fish of food 139 
until after the assay is complete. Satiation will change their response to vibrations. Place the 140 
assay cylinder holding fish on a recording stage illuminated with infrared backlight in a dark 141 
room and allow fish to acclimate for 3 min after being placed on the stage.  142 
 143 
1.3.4. Set the recording parameters in the VirtualDub freeware17: 15 frames/s, codec: x264vfw, 144 
recording duration: 3 min 30 s.  145 
 146 
1.3.5. Prepare the vibration-emitting apparatus (see step 1.2) by tuning to 40 Hz. See Figure 1 147 
for the explanation of apparatus. Rinse the vibrating glass rod with deionized water to remove 148 
any water-soluble chemicals. 149 
 150 
1.3.6. Working in the dark, place the assay cylinder on the recording stage illuminated by an 151 
infrared backlight in the dark room and allow fish to acclimate for 3 min.  152 
 153 
1.3.6.1. After the 3 min acclimation, record 3 min 30 s of video. At the onset of the recording, 154 
insert the vibrating glass rod into the water column (approx. 0.5 cm depth).  155 
 156 
1.3.6.2. Avoid making any noise or vibrations while positioning the vibrating glass rod in the 157 
water as the fish can sense even the most minor disturbances.  158 
 159 
1.3.6.3. Finish this procedure within 30 s of starting the video recording to ensure that more 160 
than 3 min of the behavior is recorded.  161 
 162 
1.3.7. Monitor the video while recording to ensure that no errors occur during this stage. 163 
 164 
1.3.8. After finishing the recording, remove the vibrating glass rod from the cylindrical assay 165 
chamber and remove the assay chamber from the recording stage. Repeat from 1.3.5 for the 166 
next fish. 167 
 168 
1.4. Video analysis  169 
 170 
NOTE: Converting the codec into a format that ImageJ can load only works on Windows 171 
operating system18 (Table 1). 172 
 173 
1.4.1. Convert the compressed avi video into a readable format for ImageJ and set analysis 174 
parameters. 175 
 176 



   

 
 

1.4.1.1. Install AviSynth_260.exe (https://sourceforge.net/projects/avisynth2/), pfmap build 177 
178 (http://pismotec.com/pfm/ap/), and avfs ver1.0.0.5 or ver1.0.0.6 178 
(https://sourceforge.net/projects/avf/). Note that this method is program/version sensitive. 179 
The provided website links will guide to the proper versions (Table 1). 180 
 181 
1.4.1.2. Run batch file by double-clicking avs_creater.bat (supplemental file). Right click on the 182 
avs video file to be analyzed (select from the avs files created by avs_creater.bat).  183 
 184 
1.4.1.3. As video analysis using the Tracker plugin in ImageJ requires loading of the ImageJ 185 
macro (supplemental file Macro_VAB_moko.txt), load the macro by drag-and-drop into the 186 
GUI shell of ImageJ. This macro will enable certain hot keys for the following analysis.  187 
 188 
1.4.1.4. In the working directory, create a new folder entitled “Process_ImageJ”. 189 
 190 
1.4.1.5. Right click on the .avs file to be analyzed (select from the avs files created by 191 
avs_creater.bat). Select the Quick mount option. After the avs file is mounted as an external 192 
drive, open the avi file in ImageJ (the avi file has name ending with “.avi”). 193 
 194 
1.4.1.6. To set the scale of the distance measurement, select the diameter of the assay 195 
chamber by drawing a straight line across the chamber using the Straight-line selection tool, 196 
then click Analyze > Set scale function. For example, input 9.4 cm if using a cylindrical dish with 197 
a 9.4 cm inner diameter. Check the radio box of Global in order to standardize the scale across 198 
all of the following video analyses. 199 
 200 
1.4.2. Convert to binary stack and run analysis.  201 
 202 
1.4.2.1. Copy the assay chamber area by using the oval selection tool and then right click and 203 
select Image > Duplicate. At this time, specify the range of frames to keep for further analysis, 204 
e.g., keep the first 2,700 frames after the vibrating rod entered the water (at 15 fps this is 205 
exactly 3 minutes of video).  206 
 207 
1.4.2.2. Clear the outside of the assay chamber and convert to a binary image by hitting the hot 208 
key 7 on the number bar of the keyboard.  209 
 210 
1.4.2.3. After the background clears and a prompt appears, add a black dot at the center to 211 
indicate the position of the vibrating glass rod by using the oval selection tool already set to 212 
black with the fill function. Click OK and a prompt will appear to move on to the threshold 213 
adjustment.  214 
 215 
1.4.2.4. Set the threshold to make a binary (all black and white) image of the fish. Adjust the 216 
threshold so that the fish is can be seen in entire video clips, and then select Apply. 217 
 218 
1.4.2.5. Run the “Tracker” plugin by hitting the hot key 8 on the number bar. Set the minimum 219 
pixel size to 100 when prompted and hit OK, generating the distance between the vibrating rod 220 



   

 
 

and the fish per frame for all 3 min of the binary video. 221 
 222 
1.4.2.6. Adjust the mis-tracking generated by noise in video. To do so, check the Results 223 
window to identify the frames that return the object number 3 or higher—indicating extra 224 
objects in those frames (e.g., particles in the water or the shade of the transparent arm of the 225 
rod) in addition to the “rod” and “fish” in the frame. Remove any extra objects using the 226 
paintbrush tool. 227 
 228 
1.4.2.7. Hit the hot key 9 on the number bar to export a binary stack of images of the entire 229 
video (in case it is necessary to reanalyze) and an .xls file with coordinates and distance data 230 
(supplementary files CF01.xls, Threshold_CF01.tif and, Trac_CF01.tif). Hot key 9 will also close 231 
all files associated with the current video. Repeat steps 1.4.2.1 through 1.4.2.6 for all replicates.  232 
 233 
1.4.2.8. Run the macro script (supplementary file JoVE_2cmVAB_template_15fps.xlsm) to 234 
consolidate multiple Tracker result files (.xls) into one spreadsheet and count the number and 235 
duration of approaches into a 1.5 cm area from the rod. Approaches not lasting at least 0.5 s 236 
will not be counted. Change the parameters of distance and time counted as an approach 237 
according to particular questions of interest. 238 
 239 
1.4.3. Release the PC disk-space after finishing all analyses. Remove mounted files to free up 240 
disk-space — avi.avi and .avi.avs files (extensions generated by the software)—by running a 241 
batch file multiunmountdel.bat in the same folder where avs_creater.bat was run in the 242 
section 1.4.1.2.  243 
 244 
2. Sleep and hyperactivity assay (24 h recording) 245 
 246 
2.1. Behavioral assay 247 
 248 
2.1.1. Acclimate five experimental fish for 4 days or more in each chamber of a custom-249 
designed 10 L acrylic recording aquarium (45.9 cm x 17.8 cm x 17.8 cm; length x width x depth, 250 
respectively) filled with conditioned water (see step 1.3.1). 251 
 252 
2.1.1.1. Separate each individual chamber with black acrylic boards making chambers equal in 253 
size, measuring 88.9 mm × 177.8 mm × 177.8 mm (Figure 2). Be sure to cover each tank to 254 
prevent fish from jumping between chambers.  255 
 256 
2.1.1.2. Set the programmable power timer to automatically turn on white LED light for 12 h, 257 
and off for 12 h every day during acclimation period (for example, set the light on at 7 A.M. and 258 
off at 7 P.M.). This will entrain the circadian rhythm of fish (if it is susceptible to entrainment).  259 
 260 
2.1.1.3. Use opaque, white acrylic boards of similar dimension to the 10 L tank as diffusers to 261 
pass white and infrared light through in order to provide diffuse light with even intensity across 262 
all tanks.  263 
 264 



   

 
 

2.1.1.4. Throughout acclimation, feed once a day with live Artemia nauplii and provide aeration 265 
through sponge filters in each aquarium.  266 
 267 
NOTE: Ensure fish are fed at consistent times (i.e., 1x per day at 9:00 A.M.) as feeding time can 268 
also affect entrainment of circadian rhythms19. 269 
 270 
2.1.1.5. Check whether fish have become acclimated by observing their latency to forage. A 271 
longer latency than in their home tank indicates more acclimation time is needed.  272 
 273 
2.1.2. The day prior to the day of the assay (3 days or more of the acclimation), replace water in 274 
the assay chamber with freshly conditioned water (see step 1.3.1). 275 
 276 
2.1.3. Set the recording parameter in the VirtualDub software17: 15 frames/s, codec: x264vfw, 277 
recording duration: 86,400 s (24 h). 278 
 279 
2.1.4. Turn on the infrared backlight behind the recording stage (see Figure 2). By observing the 280 
VirtualDub live image on screen, adjust the position of each aquarium to make them face the 281 
USB camera.  282 
 283 
2.1.5. On the day of recording, feed each fish with live Artemia nauplii, remove all sponge 284 
filters, and turn on the infrared backlight.  285 
 286 
2.1.6. Start 24 h recording in the morning (for example, the start time is 9 A.M. and the finish 287 
time is 9 A.M. the following day). Start capturing the video and secure the location to avoid a 288 
disturbance. Periodically check that the recording is running.  289 
 290 
2.1.7. After 24 h, make sure that the video saved correctly. Transfer the video to the PC 291 
workstation to track and analyze the fish’s behavior. 292 
 293 
2.2. Video analysis  294 
 295 
2.2.1. First, check the video quality by looking at the lighting. Check if there is one fish in each 296 
section, and if there are any foreign movements that may cause mis-tracking. 297 
 298 
2.2.2. Prepare the mask to avoid mis-tracking outside of the aquarium. Make two masks: one 299 
for ‘even’ and one for ‘odd’ fish, based on their sequence order in the tanks. 300 
 301 
2.2.3. Make two folders named “odd” and “even” for the masks described above. Move the 302 
tracking parameter file of SwisTrack in each of these folders. 303 
 304 
2.2.4. Open the tracking parameter file of SwisTrack tracking software (supplementary file 305 
Tracking_odd.swistrack or Tracking_even.swistrack). Specify the path to the video file and 306 
mask file, then save and exit out of the tracking parameter file. Adjust blob number and 307 
maximum pixels parameters in “Blob detection” and “Nearest neighbor Tracking” 308 



   

 
 

Ccomponents, respectively, according to the experiments. 309 
 310 
2.2.5. Double-click to run a script of win-automation software which will automatically open 311 
SwisTrack software (supplementary file swistrack_1.exe, swistrack_2.exe, swistrack_3.exe or 312 
swistrack_4.exe — these are all the same executable files), which aids in updating the adaptive 313 
background subtraction in SwisTrack. 314 
 315 
2.2.6. Open Tracking_odd.swistrack or Tracking_even.swistrack in SwisTrack software to load 316 
the tracking parameter file. After loading the parameters, press the run button to start tracking.  317 
 318 
2.2.7. Within the initial 9,000 frames (600 s, i.e., first 10 min of the recorded video), check 319 
whether fish tracking is working by looking at the adaptive background subtraction, binary 320 
mask, and nearest neighbor tracking in the component list of SwisTrack (see accompanying 321 
video). Then select Adaptive background subtraction in the Component list. 322 
 323 
2.2.8. Hit the R button on the keyboard to resume win-automation and leave the PC to track. 324 
Tracking will take 5 – 7 h per 24 h video for a desktop with 4-CPU cores and 8 GB of memory. 325 
According to needs, run multiple SwisTrack processes (including odd and even arenas of a single 326 
video file) up to the number of cores in the CPU. For example, 4-cores can handle 4 videos at 327 
once.  328 
 329 
2.2.9. During this tracking, avoid using this PC for other purposes because win-automation 330 
program automatically moves the mouse pointer. The initial 9,000 frames will be discarded in 331 
the following procedure. 332 
 333 
2.2.10. Allocate 3 Perl script files (1.fillupGaps2.pl, 2.Calc_fish_id_moko_robust, and 3.pl, 334 
3.Sleep_summary_4cm_movingWindow.pl) to the folder containing the tracking files 335 
generated by SwisTrack in the ‘even’ and ‘odd’ folders (see step 2.2.3). 336 
 337 
2.2.11. Clip one frame of the video from the video file using VirtualDub and import this clip as a 338 
photo into ImageJ. Select the length of the aquarium (45.9 cm) in ImageJ and calculate pixel/cm 339 
ratio. Write the pixel/cm ratio in 1.fillGaps2.pl in a text editor program and save. 340 
 341 
2.2.12. Launch CygWin program, a Unix emulator. Locate the SwisTrack folder that contains the 342 
3 Perl scripts by using cd on the command line. 343 
 344 
2.2.13. Run the Perl script by typing Perl 1.fillGaps.pl. These three Perl scripts will assign each 345 
tracking file to a unique chamber of the aquarium and analyze the sleep duration and 346 
swimming distance while the fish was awake. It will take 1-2 h to finish the analysis. 347 
 348 
2.2.14. Assess the text file named Summary_Sleep.txt to determine if the number of frames 349 
dropped from the analysis is acceptably low; missing fewer than 15% of frames is considered 350 
acceptable.  351 
 352 



   

 
 

2.2.14. Copy and paste the analyzed results from Summary_Sleep.txt to a spreadsheet with the 353 
macro (supplementary file Sleep_12hr12hr_TEMPLATE.xlsm). 354 
 355 
2.3.15. Run the macro to extract the summary data of tracking files. 356 
 357 
3. DASPMI or DASPEI staining of mechanosensory neuromasts 358 
 359 
NOTE: DASPMI and DASPEI staining is light-sensitive and should be done in dark conditions. 360 
Following protocol is for both DASPMI and DASPEI by using DASPMI as an example. 361 
 362 
3.1. Staining protocol  363 
 364 
3.1.1. For a total of 1 L of staining stock solution (25 μg/mL), add 0.025 g of DASPEI or DASPMI 365 
crystals to 1 L of dH2O and let it dissolve overnight. Keep solution stored at 4 °C and protected 366 
from light.  367 
 368 
3.1.2. Immerse the fish in 2.5 μg/mL DASPMI or DASPEI dissolved in conditioned water (see step 369 
1.3.1) for 45 min in a dark environment at 22 °C.  370 
 371 
3.1.2. After 45 min, remove fish from the DASPMI or DASPEI solution and anesthetize by 372 
immersion in an ice-bath of conditioned water with 66.7 μg/mL of buffered-ethyl 3-373 
aminobenzoate methane sulfonate salt (MS222). 374 
 375 
3.1.3. Mount fish in a Petri dish plate and photograph under a fluorescent microscope. Take z-376 
stack images and save as .tif files for the following analysis.  377 
 378 
3.2. Image analysis using ImageJ 379 
 380 
3.2.1. Inside the folder containing .tif files, paste a template of the ImageJ macro file 381 
(Neuromast_ImageJ.txt) and create a new folder entitled “Process_ImageJ”. In the ImageJ 382 
macro file, set the path to the current directory.  383 
 384 
3.2.2. Launch ImageJ and open the macro by dragging the macro file into the GUI or by clicking 385 
File > Open and selecting the macro file. 386 
 387 
3.2.3. Run the macro by clicking Macros > Run Macro. The macro will then automatically open a 388 
picture file to be analyzed. If the picture file does not open, click Macro > File pick up. 389 
 390 
3.2.4. For Neuromast quantification, select the region of interest using Polygon Tool. 391 
 392 
3.2.5. Hit the hot key 5 to duplicate region of interest.  393 
 394 
3.2.6. Use the Paint Tool to remove or add dots for extra or missing neuromast from the 395 
previous image and then hit 6. After hitting 6, two new windows will appear: scheme of 396 



   

 
 

numbered neuromasts dots and a table with total neuromasts quantified.  397 
 398 
3.2.7. Hit 7 to save both files: one file is stored as a .tif image file and the other is saved as 399 
an .xls file. After these files are stored, a new picture file will open for analysis.  400 
 401 
3.2.8. Consolidate the neuromast counts of each fish into one spreadsheet by running the 402 
macro script (SN_Number_Diameter.xlsm). 403 
 404 
REPRESENTATIVE RESULTS:  405 
The results presented herein are representative examples of what can be acquired with the 406 
presented methods. Therefore, results can deviate slightly from the ones presented here for both 407 
cavefish and surface fish depending on the experimental conditions. 408 
 409 
Vibration attraction behavior 410 
Representative results for VAB can be found in Figure 3 for both cave and surface fish. Note the 411 
edge-following behavior in the surface fish (Figure 3A; an attribute shared with cavefish) and the 412 
strong attraction of cavefish to the vibrating rod (Figure 3B). The peak attraction level was 413 
observed near 35 Hz for cavefish (Figure 3D) but not surface fish (Figure 3C), representing a key 414 
difference in the behavioral phenotypes of the two morphs. The peak in attraction around this 415 
frequency most likely represents the frequency of vibrations made by prey or food items20,21.  416 
 417 
Sleep and hyperactivity assay 418 
The criteria used herein to define sleep fit the response thresholds previously determined to be 419 
effective for Astyanax11. Sleep is characterized by extended periods of quiescence and is defined 420 
as immobility of >60 s and elevated response threshold12,22,23. In comparison to surface fish, 421 
shorter sleep durations occur in larval and adult cavefish11,12, therefore, sleep assays are an 422 
effective way to behaviorally phenotype Astyanax of all ages. While cavefish showed less-sleep 423 
(Figure 4B, shorter sleep duration in cavefish), they are also hyperactive (Figure 4A).  424 
 425 
DASPMI or DASPEI staining of mechanosensory neuromasts 426 
Neuromasts are composed of sensory cells that can be easily stained with DASPEI or DASPMI and 427 
observed in vivo under a fluorescent microscope. The presented result was the result of DASPMI 428 
staining. The number of superficial neuromasts is enhanced in the cranial region of the cavefish 429 
in comparison with surface fish (Figure 5C,D), and both the size—a proxy of the number of the 430 
mechanosensory hair cells—and number of superficial neuromasts are positively correlated with 431 
the level of vibration attraction behavior (number of approaches to the vibrating rod: Figure 432 
5A,B).  433 
 434 
FIGURES AND TABLES: 435 
Table 1. List of freeware used in these analyses, and source website.  436 
 437 
Figure 1: Schematic of vibration attraction behavioral assay experimental equipment. A glass 438 
rod attached to a speaker is tuned to a frequency of 40 Hz and submerged to a depth of approx. 439 
0.5 cm at the onset of video recording. This figure is modified from Yoshizawa et al.5.  440 



   

 
 

 441 
Figure 2: Schematic of sleep assay experimental equipment. Tanks are custom-made from 0.7 442 
cm thick transparent acrylic boards; septa are 0.3 cm thick completely opaque black acrylic 443 
boards. Opaque black acrylic boards are used for this part of the tanks so that fish cannot see 444 
each other. (A) Top view: Note that the outer chambers of the tank have tilted inward septa to 445 
accommodate differences in camera angle. (B,C) Front and side views, respectively. (D) Array of 446 
three tanks backlit with infrared light passing through a diffuser in order to homogenize the 447 
intensity of light across all tanks. Note that each tank’s orientation is adjusted so that all the 448 
movements of each fish in its respective chamber are visible. Panel (C) and (D) are modified 449 
from16. 450 
 451 
Figure 3: Representative results of a 3-minute vibration attraction behavior assay. (A,B) Top 452 
view of the swimming path of surface fish (A) and cavefish (B); redlines are traces of the path 453 
that the fish took during the 3-min video. The black dot at the center indicates the location of the 454 
vibrating glass rod. wrMtrck ImageJ plugin was used to visualize the fish traces24. (C,D) 455 
Comparison of results from surface fish (C) and cavefish (D) exposed to multiple frequencies of 456 
vibration. Each dot represents each fish. Dark shaded areas are interquartile range. Note that 457 
across all frequencies, surface fish do not show notable attraction to vibration whereas cavefish 458 
show a maximum in attraction near 35 Hz. (C, D) Modified from 16. 459 
 460 
Figure 4: Representative results from several measures for activity analysis—Diurnal activity 461 
patterns in surface fish and cavefish. (A-B) Day (yellow bars) and night (black bars) scores of 462 
swimming distance (m per 10 min, A), and sleep duration (1,000 s/12 h, B). Each bar represents 463 
the mean ± standard errors of mean. Blue stars indicate the level of significance for statistical 464 
comparisons between surface fish (Sf) and cavefish (Cf). Cavefish and surface fish have 465 
significantly different day-night activities. Two-way ANOVA statistics for each phenotype are: for 466 
swimming distance (A) between surface fish (Sf) and cavefish (Cf): F1,399 = 185.8, P < 0.001, 467 
between day and night: F1,399 = 26.9, P < 0.001, interaction between population and day-night: 468 
F1,399 = 3.6, P = 0.060 (not significant: n.s.); for sleep duration (B) between Sf and Cf: F1,399 = 237.9, 469 
P < 0.001, between day and night: F1,399 = 164.1, P < 0.001, interaction between population and 470 
day-night: F1,399 = 26.5, P < 0.001. For both analyses, N = 200 and 201 for surface fish and cavefish, 471 
respectively. The difference between day and night activities were tested by post-hoc paired t-472 
tests with Bonferroni corrections and denoted by black asterisks. *** denotes P < 0.001. ** 473 
denotes P < 0.01. A subset of the data was reused and updated from 11. 474 
 475 
Figure 5: Representative results of the relationship between VAB and neuromast. (A,B) The 476 
relationship between VAB and neuromast number and size in cavefish, surface fish, and the F1 477 
hybrid progeny of surface fish x cavefish. Note that the normalized scores of vibration 478 
attraction (square root of number of approaches) is positively correlated with neuromast 479 
abundance (Pearson correlation coefficient r = 0.62, P < 0.001) and neuromast diameter 480 
(Pearson correlation coefficient r = 0.31, P < 0.01). Panel A and B are modified from5. (C,D) 481 
DASPMI staining of neuromasts in the cheek region of (C) a surface fish and (D) a cavefish. Scale 482 
bar in inset (C) and (D) are 1.0 mm. 483 
 484 



   

 
 

DISCUSSION: 485 
These presented methods are easy-to-access but can be complicated to perform due to the 486 
nature of its freeware origins. Therefore, it is highly recommended to perform trial assays and 487 
analyses before any actual experimentation.  488 
 489 
The rate of data generation can be rapid once the experimental and analytical framework are 490 
established. Once established, it is possible to record two fish in 7 min for the VAB assay, 30 fish 491 
in 24 h for the activity/sleep assay, and one fish in 2.5 to 3 min for neuromast imaging, starting 492 
from MS222 anesthesia to final image capture. The durations of the video and image analyses 493 
can vary considerably depending on the performance of the computer used. By using a PC with 494 
a 4-core CPU and 8 GB of RAM, VAB analysis can take 5-7 min per fish, activity/sleep analysis can 495 
take 6-8 h per group of 30 fish, and neuromast image analysis can take 5 or 10 min per fish (single 496 
side or both sides of images of the cranial region, respectively). Commercially available tracking 497 
software (Table of Materials) is an alternative for video analysis. It is very powerful in animal 498 
tracking but expensive (e.g., base software ~USD$5,000USD and multi-tracking module 499 
~USD$4,000). At this moment, our tracking methods seem to achieve comparable accuracy of 500 
tracking, especially for the activity/sleep analysis, i.e., missing frames are typically lower than 501 
15% of total frames. This method also showed a high reproducibility in four replicates 502 
(Supplementary Table 1). However, the difficulty in developing this system without an 503 
understanding of basic coding in Windows OS and Linux/Unix OS must be acknowledged. 504 
 505 
During fish acclimation periods, and before and during behavioral assays, it is essential to provide 506 
the best possible and consistent living conditions for experimental fish. This includes feeding 507 
high-quality food at the same time and amount every day and maintaining high water quality 508 
(low ammonia, nitrates, nitrites, and dissolved organics, ~ pH 7, and similar conductivity around 509 
700 µS). It is also important to perform assays in an area not disturbed by noises. Noisy footsteps, 510 
and clattering sounds may change behavioral responses and activity/sleep-patterns. To reduce 511 
the level of damage to mechanosensory units while handling fish, it is helpful to use a fine-mesh 512 
fish net while transferring fish; this will help to avoid damaging the mucus cupula of neuromasts.  513 
 514 
DASPEI dye has sublethal effects on the fish, but excessive exposure can result in toxic effects. 515 
For example, immersing the fish in the DASPEI solution for 2 h will raise the chance of mortality 516 
during the recovery of post-anesthesia. DASPEI staining is light-sensitive and therefore should 517 
be done in dark conditions. 518 
 519 
As for freeware installation, AviSynth software, Avisynth Virtual File System (avfs), and Pismo File 520 
Mount Audit Package (pfmap) required specific versions to work together cohesively. It was 521 
confirmed by this protocol that avfs (v1.0.0.5), AviSynth (2.6.0) and pfmap (1.7.8) work together, 522 
but at least the latest pfmap build did not work for the file-mounting procedure. For this reason, 523 
pay attention to the software versions (Table 1). VirtualDub works better under the 32-bit version 524 
instead of 64-bit. The setting of 15 frames per s provides a good time resolution and does not 525 
require excessive storage volume (1.6 GB for a 24-h sleep assay video and 3 MB for a VAB video). 526 
For ImageJ, the major difficulty can come from setting file paths in the macro. In Windows OS, 527 
the file path can be generally expressed as “C:Document\my Document\...”. The ImageJ macro 528 



   

 
 

runs under the Java environment and needs an extra “\” for the file path, that is, 529 
“C\:Document\\my Document\\...”. Please see the example ImageJ macro file. In addition, it may 530 
be necessary to install two plugins, Slice Remover and Object Tracker25, and assign the hot keys 531 
(Keyboard shortcuts) 6 and 8, respectively, so that the analyses work seamlessly (Plugins > 532 
Shortcuts > Add Shortcuts…26). SwisTrack has a function to set the tracking parameters, but it is 533 
possible that a freeze and/or crash may occur while setting the tracking parameters. It is better 534 
to edit the parameter in a text editor app such as Notepad++. For details of parameter settings, 535 
please see27. The Cygwin (Unix emulator) installer includes a package installer to install the Perl 536 
package, which is not included in the default install setting. It is recommended to specifically 537 
select the Perl package during installation of Cygwin.  538 
 539 
Although, this procedure is limited to a lateral line-based behavior (VAB) and swimming activity 540 
and sleep, this animal tracking system can be adapted to other behaviors including stereotypic 541 
repetitive behaviors, social interactions, and the asymmetric usage (left/right) of cranial 542 
neuromasts during foraging (laterality)13, although these methods may require shallow arenas 543 
such as those suggested by idTracker14. With a suite of evolved behaviors, one may apply 544 
different scripts to analyze the tracked X- and Y-axes data and investigate different behavioral 545 
patterns. This analysis pipeline is intended to provide a foundation to resolve the mechanism of 546 
the evolution in multiple behaviors, and also how comorbid autism-like behaviors are regulated 547 
by genetic, epigenetic, and the environmental factors.  548 
 549 
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Table 1. List of freeware used in these analyses, and source website. 

Software Analysis version

avfs Activity/sleep Version 1.0.0.6

Avisynth VAB Version 2.6.0

Cygwin Activity/sleep Version 2.11.0

ImageJ VAB and DASPEI Version 1.52e

pfmap Activity/sleep Build 178

SwisTrack Activity/sleep Version 4

WinAutomation Activity/sleep Version 8

Windows operating system VAB and Activity/sleep 7, 8 or 10

x264vfw All analyses NA
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Table 1. List of freeware used in these analyses, and source website. 

website

http://turtlewar.org/avfs/

http://avisynth.nl/index.php/Main_Page

https://www.cygwin.com/

https://imagej.nih.gov/ij/

http://pismotec.com/download/ (at “Download Archive” link at the bottom)

https://en.wikibooks.org/wiki/SwisTrack

https://www.winautomation.com/ (free stand-alone app for this procedure)

https://www.microsoft.com/en-us/windows

https://sourceforge.net/projects/x264vfw/



Name of Material/ Equipment Company Catalog Number Comments/Description

4-Di-1-ASP (4-(4-

(dimethylaminostyryl)-1-

methylpyridinium iodide)

MilliporeSig

ma D3418

880 nm wave length black light

Advanced 

Illumination BL41192-880

avfs freeware Version 1.0.0.6 http://turtlewar.org/avfs/

Avisynth freeware Version 2.6.0

http://avisynth.nl/index.p

hp/Main_Page

Cygwin freeware Version 2.11.0 https://www.cygwin.com/
Cylindrical assay chamber (Pyrex 

325 ml glass dish) Corning 3140-100 10 cm diameter 5 cm high

Ethovision XT

Noldus 

Information  

Technology, 

Wageningen

, The 

Netherlands Version 14

https://www.noldus.com/

animal-behavior-

research/products/ethovis

ion-xt

Fish Aquarium Cylinder Soft 

Sponge Stone Water Filter, Black

Jardin 

(through 

Amazon.co

m) NA

Sponge filter for 

Sleep/hyperactivity 

recording system

Grade A Brine shrimp eggs

Brine shrimp 

direct BSEA16Z

ImageJ freeware Version 1.52e https://imagej.nih.gov/ij/

Table of Materials Click here to access/download;Table of Materials;Worsham_JoVE_Materials_ver2.xls
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macro 1.8/12.5-75mm C-mount 

zoom lens Toyo NA

Attach to USB webcam by 

using c-mount, which is 

printed in 3-D printer

Neutral Regulator Seachem NA

Optical cast plastic IR long-pass 

filter

Edmund 

optics 43-948

Cut into a small piece to 

fit in the CCD of USB 

webcam

pfmap freeware Build 178

http://pismotec.com/dow

nload/ (at “Download 

Archive” link at the 

bottom)

Reef Crystals Reef Salt

Instant 

Ocean RC15-10

SwisTrack freeware Version 4

https://en.wikibooks.org/

wiki/SwisTrack
USB webcam (LifeCam Studio 

1080p HD Webcam) Microsoft Q2F-00013 Cut 2-2.5 cm of the front

WinAutomation freeware Version 8

https://www.winautomati

on.com/ (free stand-alone 

app for this procedure)

Windows operating system Microsoft 7, 8 or 10

https://www.microsoft.co

m/en-us/windows

x264vfw freeware NA

https://sourceforge.net/p

rojects/x264vfw/
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Video: 
 
1. Move the ethics statement after the interview of the Dr. Yoshizawa to mark the start of the 
protocol section. 
Addressed 
 
2. 1.49: Video analysis title card is not needed as it is describing the behavior assay. — so 
remove this title card. 
Addressed 
 
3. Figure 5 in the video: Add scale bar in the images taken with the microscope (panel C and D)  
Addressed 
 
4. After all the changes please ensure that the video is no more than 15 min in length. 
Addressed 
 
Manuscript: 
1. The editor has formatted the manuscript to match the journal's style. Please retain the same. 
We did. 
 
2. remove Fig. 4C, 4D, 4E and remove their fig legends.  
Addressed 
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“Neuromast imaging and free software-based tracking of behavioral activities in the Mexican 
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Supplementary Table 1. Repeatability of the results from a tracking analysis over four 
independent replicates using Cavefish. 

 
 
 
 

Measurement was repeated four times in the same video by making binary masks each time. 
Ranges for the ratio of standard deviations/means were calculated from 9 individual fish’s 
range of standard deviations divided by means in four replicates. Relatively high score of this 
ratio in sleep duration is due to short sleeping duration of cavefish (mean: 0.149 hrs; mean of 
swimming distance: 4,758.8 m per 24 hrs). 
a: Same as repeatability, r  
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Measurements N 
Cronbach’s 

alpha 
Intraclass 

correlationa p 
Range of Standard 
deviation/ Means 

Swimming distance 9 0.985 0.944 < 0.001 0.004-0.069 
Sleep duration 9 0.995 0.967 < 0.001 0.000-0.312 
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